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OVERVIEW

This user guide explains how to use Investigations Case Management (ICM).

@ Investigations Case Management [Demonstration]

System Incident Reports Information Reports Cases Tasks Property Search HNoticeboard Reporting Admin Help & TECH DOCUMENTATION

jade

Recent

+ B Case Ffile i Tasks Noticeboard posts c =
+ @ Homicide Fil :
omicide Fie New In Progress Overdue Rejected Tyvpe Latest Post Noticeboard Details
+ Forensic Note
0 1 i 0 Global  24/08/2017 11:47 Global Noticeboard Cake in the kitchen downstairs

+ B General Case Note X

o N Case 24/08/2017 11:44 [2] Homicide - John SMITH Case reviewed on
+ B Research / Analysis Activity For Review For Autf M Detail

n or Review arAdtm ore betal Case  24/08/2017 11:43 [7] Arson Report at 15 Reberts Firebug found
+ Surveillance Activity 0 0 0

m, Case 15/07/2015 11:54 [2014-1] Operation Hagley Checking access from a case w
+ Telephone Intercept Summary
. ATy RS . N Case 11/04/2014 10:57 [3] Document tampering POst 1 from me

dasK results

" Different Doc type Global General Staff Notices
+ Contact Number For Review [VCE:VIOO  Accepted Rejected Team Investigation Team 3
+ Document 0 i 0 0

Firearm

Tmana -

e

For Review Rejected
s Follow up on Case 43.
* Change Case Manager for Case 29. 0 0
Search

You have expired active search requests
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Download the Latest Help File

An updated, searchable help file is available - Download ICM Help.

Once you have downloaded the help file you'll need to link to it in your installation of ICM:
1. Select Admin > System > Settings.
2. Paste your URL for the help file in the Help file base URL field.

3. To specify the landing page for the help file, enter default.htm in the Help index page field >
Select Default.

4. Save your changes.

1
i o SvStern SEttingS Security  Agency Backup & Housekeeping i
i Options i
: Database ID .Dernu:unstration []Laptop system :
i Environment Demonstration i
i Application name .ICM i
: Language .E'“;. ch (New Zealand)] :
i Contact number format [Free Format i
i Max image or document size 50 MB i
: Max email attachment size 4 MB i
i Media attachment directory O:fjscComis/server/c_misc/MediaAttachments :
I |
: Hide no access results on searches O :
i Allow source entities directly added to case [¥] (Allow source entities to be introduced directly into a case 'ai
: Single source entity relationship |:| (Allow only one relationship type to be configured betweeni
i Include default source entity relationship O (Include the system default relationship type 'references’ -:::
i Enable Phase and Line of Enquiry feature [¥] Phase/LOE/Review/Disclosure collapsed by default [ i
: View Word file as PDF | (Clicking view button for a document entity will display a P[:
i Display Entity URM [v] For Contact Mumber, Location i
: Show user details on attributes with history | :
i Hide the 'Outlock’ tab on all forms [ i
: Allow case centric storage locations [¥] :
I |
: Help Options :
i Help file base URL https://webl.jscdcmis.cnw.co.nz/JadelnvestigatorUserGuide/ i
i_ Help index page default.htm J:

6.0.8 -06/12/2018
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GETTING STARTED

This section covers the basics of how to find your way around Investigations Case Management (ICM).
You'll learn how to:

= Open and exit ICM.

s Change your password.

= Navigate around the different parts of the application.

m  Use keyboard shortcuts and common types of controls on screens you'll be using frequently.
Accessing ICM
Log On and Off

1. Double-click the application I icon on your desktop.
2. Enter your User ID and password in the fields provided.
3. Select Logon or press Enter.

If your administrator has selected the Allow direct logon from Windows option under System
Settings, the Logon screen isn't displayed, and the application window opens immediately.

If you enter an incorrect User ID or password, you'll be allowed a further (system-defined)
number of retries before you're locked out of ICM.

4. To log off ICM, select System > Log Off.

INVESTIGATIONS CASE MANAGEMENT

Llger D 11D

Fassword FEHEE .

Investigations Case Management User Guide 6.0.8 -06/12/2018
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Change Your Password

You might be required to reset your password the first time you log on to ICM. This is because your initial
password is set by your administrator.

1. Select your username on the main menu > Select Change Password.

2. Enter your existing password in the Current Password field.

3. Enter your new password in the New Password and Confirm Password fields.
4, Select Save or press Enter - Your password will be reset.

Your administrator sets password length and expiry.

o o 1

¥ Change Password x

Flease enter your old and new password details below

Current password HA L A
Mew password L&
Confirm passward L&

Investigations Case Management User Guide 6.0.8 -06/12/2018
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Change Another User's Password

If you have the Can reset password for another user permission, you can reset the password for another

user.

For details about managing security permissions, see the Admin Guide.

To change the password for another user:

1.

2
3.
4

Select Admin > Security > Change Another User's Password.

Enter your password in the field provided > Select OK.

Select the Search & icon beside the Usercode field.

Enter the first few letters of the user's name in the Search field > Select the user > Select OK.

Reset password for another user

Usercode JI0006 [+}
Password

Confirm password

Ha

jof {
ii By
:i By

¥ Select User

Search m|

Migration, (MIGRATE)

BRIAN, Clark (DEMOZ)
DOCUMENTATION, Tech (1IDOC)
MASON, Robert (DEMO1)
MCDONALD, Shirley (CNWSAS1)
THOMPSON, Greg (DEMO3)
USER, Demo (110005)

Investigations Case Management User Guide

6.0.8 -06/12/2018



Investigations Case Management

Getting Started

See a History of Recent Logon Attempts for Your User ID

1. Select your username > Select Recent Logon History.

Any unsuccessful logon attempts and account deactivation details will display in red.

2. To see the password used in an unsuccessful logon attempt, select the Show password used for

failed logon attempt checkbox.

You can use this feature to see what you mistyped or whether someone was trying to guess your

password.

3. Select Close when you have finished using this screen.

e = |
¥ Recent logon details by

l !
l !
i Action Date/Time Workstation Failed password - i
I| Logon 05/07/2017 09:10 CNWSHSA :
i Logoff 04,/07/2017 16:55 CNWSHEA i
Il |Logon 04/07/2017 09:08 CNWSHSA :
| Logoff 03/07/2017 18:06 CNWSHSA :
i Logon 03/07/2017 09:16 CNWSHEA i
: Logoff 30/06/2017 18:22 CNWSHBA :
i Logon 30/06/2017 09:43 CNWSHSA i
: Logon Unsuccessful 30/06/2017 09:42 CHWSHSA :
i Logoff 29/06/2017 17:38 CNWSHBA - :
! I
: [] show password used for failed logon attempt i
oo o I
Close ICM

Use any of these methods to close ICM:
s Select System > Exit.
= Select the Close x icon in the top right corner of the application window.
s Press Alt+F4.

Investigations Case Management User Guide
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Quick Start Basics

The table lists the main things you can do in ICM. These tasks might vary depending on your business
process.

Task

Start a new investigation or
case

Record information in an
existing investigation or case

Record a reported or observed
incident that might be
investigated

Record information that isn't
related to any current
investigation or case

Assign work

Record information about a
person, address, phone
number, and more

Record links between entities

Investigations Case Management User Guide

Action

Create a case to start a new investigation or create an incident
report to record any activities that might require further
investigation.

See Creating cases or Create an Information or Incident
Report.

A case is used as a container to hold information about an
investigation. Your business unit may use different
terminology.

Create a case note to record these activities.
See Add a case note.

ICM uses case notes to record the activities that took place
during an investigation, information gathered, and what was
discovered as a result.

Create an incident report to record any activities that might
require investigation.

Create an information report to record miscellaneous
information that isn't related to a current investigation or case.

Create a task from a case, case note, information report, or
task result to assign work. You can use the Tasks feature to
assign work to users.

See Creating a Task.

Open a source entity and create an entity. Entities are used to
record information about real world items like people,
addresses, and phone numbers.

You can only create entities in a case note, information report,
task, or task result.

See Adding Entities to Source Entities.

Open a source entity and record a relationship (or link)
between entities.

You can create entity relationships in case notes, information
reports, tasks, or task results.

See Entity to Entity Relationships.

6.0.8 -06/12/2018
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Record images of entities Open an entity and upload an image to associate it with the
entity.

An image is saved as an image entity.

One image can be related to several entities.

Record information that Select the time zone icon beside the date or time control in
relates to a different time which you want to record information from another time zone.
zone

See Time Zones.

Search for Information Search entity types, cases, case notes, information reports,
and specific entity types for the information you need.

See Searching.

Receive an alert when another |Place a watch on any entity. When a user interacts with the

user updates or looks at an entity in a particular way, you receive an alert.
entity See Watches.
Combine information Use any of these methods to collate intelligence:

m  Search for entities that are directly or indirectly related.
See Search for Related Entities.

m  Use entity relationship diagrams to see graphical
representations of related entities.

See Diagramming.

m  Use convergence searching to find common entities related
to case notes, information reports, tasks, and task results.

See Case Note Convergence.

Investigations Case Management User Guide 6.0.8 -06/12/2018
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Navigating Around ICM

This section shows you the common work spaces in ICM, how to navigate around the application, and the
names of frequently used functions.

ICM is made up of the following main areas:
Main menu Provides access to most application functions.

Logged on Displays your User ID and if selected shows the User ID menu.
User ID

Logo Section The logo section displays the logo of your agency or the default Jade logo.

Section Select the section you want displayed by selecting the appropriate section icon.
selection
menu

Information This area is where the information screens you work with are displayed.

Pane You can have many screens open at the same time but only one screen at a time

can be displayed.

You can "tab" through the screens you have open by pressing Ctrl+Tab.

Navigator The Navigator displays a Notes area where you can type, copy and paste text
together with any one of the sections (Alerts, Favourites, Recent, Forms or Entity
Trail).

You can adjust the width and height of the Navigator by dragging its boundaries.

Investigations Case Management User Guide 6.0.8 -06/12/2018
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Home Screen

The screen that displays when you first log on to ICM shows information about:
= Tasks
= Task results
= Case notes
= Search
m  Logon activity
m  Noticeboard posts
Any items that need your attention are selectable.

Tiles show how many items there are and what state they're in. This makes it easy to link through to the
area that needs attention.

You can select the Home # icon at any time to return to this screen.

o o o o e e e o e e o e e e e e e 4
! ]
! ]
! ]
! ]
! ]
1 ™
I
! ade |
! ]
! ]
I
Recent 1
! ]
: + B CaseFie Tasks Noticeboard posts c= |
+ B Homicide Fi |
: ormicide Fiie New In Progress Overdue Rejected Tyvpe Latest Post Noticeboard Details 1
+ B Forensic Note
Global  24/08/2017 11:47 Global Noticeboard Cake in the kitchen downstairs I
I
+ B General Case Note X 1
ase : omicide - John ase reviewed on
[} N . C 24/08/2017 11:44 [2] H de - John SMITH C d |
+ B Research / Analysis Activity For Review For Autt M Detail i
: n or Review er Aum ore et Case  24/03/2017 11:43 [7] Arson Report at 15 Reberts Firebug found 1
+ Surveillance Activity 0 0 0 1
| m, Case 15/07/2015 11:54 [2014-1] Operation Hagley Checking access from a case w
i Telephone Intercept Summary 1
m . Case 11/04/2014 10:57 [3] Document tampering POst 1 from me ]
1+ Autopsy Findings
1 . Different Dot type Task results Global General Staff Notices :
: + [ Contact Number For Review  [ENER:G0T Accepted Rejected Team Investigation Team 3 1
I
I| + B Document 0 1 0 0
I
: + ™ Firearm 1
(] B Tm=na - 1
. '
I
I + Fallow up on Case 43 For Review Rejected 1
1 * Change Case Manager for Case 29. 0 0 ]
! ]
| ]
| I
| Search I
1 You have expired active search requests :
| ]
1 User 1
| I
| 2 I
| I
| I
| I
| I
| I
| I
I el !
1A * © & |
e L L L L T I T T T T T e e e e =
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Navigator

The Navigator is the pane on the left when you open ICM. It provides quick access to commonly used
functions.

The logo section displays the default ICM logo or the logo that has been configured for your agency. You
can specify the logo displayed. See the Admin Guide for details.

The Navigator also has the following selectable sections. Only one section can be displayed in the
Navigator at a time. You can display these sections in the Navigator or as independent, floating panes.

See Floating and Docking Sections.

To change the pane displayed, select the appropriate icon at the bottom of the Navigator, or use the
keyboard shortcut.

You can hide or show the Navigator if you need more space.
To do this, select the Options =icon > Select Hide Navigator or Show Navigator.
You can also resize the Navigator by dragging the right border of the pane left or right.

If you want your resizing saved for the next time you open ICM, you can set this in your user preferences.

B [2014-1] Operation Hagley

M [5] Theft of Vehicle

B [15] Reg cert
[34] Checking validity of suspect statements
B [7] Arson Report at 15 Reberts Lane, Adelaidf:
[2] Upload of PIN Register for 4103492232
[4] Evidence

s [8] BROWN, Harold

[t¥

* Follow up on Case 43.
* Change Case Manager for Case 29.
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Alerts

See a List of All Your Alerts
1. Select System > Alerts.

2. Use the Category dropdown field to narrow alerts by category.
3. Use the Type dropdown field to narrow a selected alert category by type.
4

Select the Calendar H icons beside the From and To fields to specify a date range for the alerts (if
required).

5. Select the Refresh ' icon to display the list of alerts according to your selection criteria.

1
| Alerts !
I 1
I 1
: Category |Miscellaneous - Frem |10/06/2011 | B :
| Type All Types - To 29/06/2017 | C:
I 1
: Category Type Entity » Date/Time :
| | Miscellaneous Active search & name search joe bloggs 02/02/2016 09:25

&) I
: Miscellaneous Active search & Person JONES 07/08/2015 09:10 :
: Miscellaneous  Trigger Alert g Denby Forensic Monitoring 22/05/2014 00:03 :
| |Miscellaneous Active search & Person JONES 16/05/2014 10:57 1
: Miscellaneous Active search & Person JONES 16/05/2014 10:49 :
: Miscellaneous Active search & An alert for Person called Frik 13/05/2014 12:23 1
| |Miscellanecus Active search & An alert for Person called Frik 13/05/2014 11:47 :
: Mizcellaneous  Trigger Alert g User deactivated 12/05/2014 13:37 :
: Miscellaneous Task Result [23] Interim: Collation completed 23/04/2014 10:42 1
| |Miscellanecus Task Result [25] Final - Resclved: Collation completed 23/04/2014 10:42 :
: Miscellaneous [ [12] Address check 22/04/2014 14:36 :
| | Miscellaneous [®] [3] Finger print mail found at suspect's home 22/04/2014 14:34 1
: Mizcellaneous [ [19] Obtain PIN Register for 4103494567 22/04/2014 14:33 :
: Miscellaneous Task Result [21] Final - Resclved: Completed search and interviews 27/01/2014 16:00 :
| |Miscellaneous Task Result [19] Final - Resclved: Reg details attached 27/01/2014 14:57 1
: Miscellaneous (W [10] Search heuse for missing mail 20/01/2014 09:45 :
:- Miscellaneous [®] [15] Fingerprint cookie jar 20/01/2014 09:45 _:
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Open an Alert
To see a list of alerts over a selected time, select System > Alerts.
To see an alert in detail:
1. Use either of these methods to display an alert in ICM:
o Select the Show Alerts [N icon.
o Press Ctrl+1.
You can also open an alert from the list of alerts.
Simply double-click to do this.

2. Double-click an alert in the Navigator to see details about it.

Investigations Case Management [Demonstration] - [View Audit Entry]

System Incident Reports Information Reports Cases Tasks Property Search HNotice Board Reporting Administration Help & TECH DOCUMENTATION

) All Case Types Search * = * :
SRR RS 25 Data collection by covert inter Default Case Note

E 2
ﬁ Hemicide - John SMITH

*)* View Audit Entry

- & Overt view/update Audit entry details
[48] revelver

- & Search Results

Entity User THOMPSON, Greg (DEMO3)

Action Search User | THOMPSON, Greg (DEMO3)
Workstation WYNSW1A
Business unit

Business region

Details All Entities Search

Audit entry properties

Property Value before Value after
Criteria [ Authorised ]

( Show deleted=Ffalse )
Search words=revolver [Any words=false, Use Keyword]

|

|

|

|

|

|

|

|

|

|

|

|

|

|

Audited on 11/04/2016 10:13 :
|

|

|

|

|

|

|

|

|

|

|

|

|

ol |
( Fictitious - Include ) (]

Edit an Alert
To edit an entity associated with an alert, right-click the entity in the Navigator > Select Edit Entity.

- & Watches: Overt View/Update
[48] revolver

- & \Watches: Search
[48] revolver

- Q Active Searches

Case File: [&] Theft of Wehicle
- Q@ Active Search Smith

Case File* T&1 Theft Af Wahirla
View Alert

Edit Entity

Remove Selected

i
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
!
: - Q@ Active Search Smith
1
1
1
1
1
1
1
1
1
1
1
1
1
1
!
: Remove All
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Remove an Alert from the Navigator
1. Select the Show Alerts Y icon to show the Alerts pane in the Navigator.
2. Use either of these methods to remove an alert from the Navigator:
o Right-click the alert you want to remove > Select Remove Selected.
o Select the alert you want to remove > Press Delete.
You can also select Remove All to remove all alerts.
Alerts you have removed are still available from the list of alerts.

[ ——]

- & watches: Overt View/Upc Tasking activi
[48] revalver
- & \Watches: Search

i

L e e e e e e

LU

[48] revalver View Ale
Edit Entity

Remove all

Open a Trigger Alert
1. Select the Show Alerts I icon at the bottom of the Navigator.

You'll see the trigger rules that generated the notification and the entities involved.

2. To open the item that has triggered the alert, right-click it or select the Options =icon > Select
View matched object.

3. To see how the trigger is set up, select View trigger definition.

= |
- & Watches: Overt View/Update a Trigger Alert :
48] revolver

taa] Matched trigger definitionfATION, Tech (JIDOC) Notified at 14/03/2018 11:01 |

- & watches: Search I
B 48] revolver Assigned as Case Officer :
- Q Active Searches Notification title 1
- @ Active Search Smith e @ G 1
Case File: [2] Homicide - John SMITH :

- Q@ Active Search Smith Notification message |
Case File: [6] Theft of Vehicle Assigned as Case Officer 1

- Q Active Search Smith :
I

I

I

I

I

I

I

I

I

|

Case File: [6] Theft of vehicle

- Triggers
- Assigned as Case Officer: [1] Vehicle T

Trigger rule infarmation

WilEE [1] vehicle Theft - SM2332
Rule 1 1 Case File.Case officer is changed

[1] Vehicle Theft - SM2332
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Favourites Section

The Favourites section in the Navigator stores bookmarks for entities you have recently accessed.
Select the Show Favourites ™ icon at the bottom of the Navigator to display this section.

Add an Item to the Favourites Pane in the Navigator

Use either of these methods:

= Drag and drop an entity from a screen or your Recent section to the Favourites pane.

= Right-click an entity in the Recent section > Select Add to Favourites.

Case File

Homicide File

+
1 - -

Forensic MNote

-

General Case Note

[51] Body fadiz. szt
[1] vehicle dit Entity

Remove All

[11] Arrest
[34] Check

Open an Item from the Navigator
Use either of these methods:

= Double-click the item.

= Right-click the item > Select Edit Entity.

T 1
e
[}

i B [2014-1] Operation Hagley Tasking activity
| @ [6] Theft of Vehicle
i [2] Homicide - John SMITH
| B [15] Reqg cert
i
|
|
|

[34] Checking validity of su
! B [7] Arson Report at 15 Rebs
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Remove an Entity from the Favourites Section

Entries remain in the Favourites section until you remove them.

1. Select the Show Favourites ™ icon in the Navigator.
2. Right-click the entity you want to remove > Select Remove Selected.

To remove all entities from your list of favourites, right-click anywhere in the Favourites section
> Select Remove All.

r ___________________________________________ I
o

I
! B [2014-1] Operation Hagley
| @ [6] Theft of Vehicle

I

I

I

]

I

I

I

i i
1 ] e - |
: [2] Homicide - John SMITH Edit Entity :
: B [15] Reqg cert :
I

I

I

I

I

I

I

i ) . Remove Selected

| [34] Checking validity of sug

I Remowve All

| B [7] Arson Report at 15 Rebererearepreermrrs

:l [2] Upload of PIMN Register for 4103492232
___________________________________________ |

Access the Recent Section
The Recent section in the Navigator lists the entities you have recently updated or looked at.
These entities are grouped by type.

1.  Select the Show Recent [ icon at the bottom of the Navigator.

2. Use the expand * and Contract - icons to hide or show items on the tree.

+ W Case File
+ M Homicide File
= Forensic Note
[5] [Draft] Forensic

i
I
I
I
I
I
I
I
I
I
I
I
I
i
| [4] Evidence
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I

[6] Fingerprint Repa
[8] Red hair folicle f
[7] Paint analysis fri
[2] Forensic Examin

1
I
I
I
I
I
I
I
I
I
I
!
[1] Forensic Examin :
I
I
I
I
I
I
I
I
I
I
I
+ General Case Note ]
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Open an Item from the Recent Section

1. Select the Show Recent Q icon in the bottom left corner or press Ctrl+3.
2. Use either of these methods to open the item:

o Double-click the item you want to open.

o Right-click the item > Select Edit Entity.

e e e e e e e e e — T T T T T T A
_ i
I
1
|

+ @ Case File y Tasking
+ B Homicide File !

Mo new tag

Forensic Note :
. You have a

[5] [Draft] Forensic :

[4] Evidence Mo tasks al

Remove Items from the Recent Section
To remove one item from the Recent section, right-click it > Select Remove Selected.

To remove all items from your recent list, right-click it in this area > Select Remove All.

+ W Case File Tasking activity
+ W Homicide File

Mo new tasks current

It

Forensic Mote
You have owverdue tas

[5] [Draft] Forensic

Mo taclc swaiting Frasy

Edit Entity

[1] Forensic Exa
[6] Fingerprint

[8] Red hair foli Remove All

[7] Paint analysi Add To Favourites
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Forms Section

The Forms section lists the items you have open. To use this section:

= Select the Show Forms [ icon at the bottom of the Navigator to display this section.
= Select items here to flick between them.
You can also use the tab strip to switch between items you have open.

= To close a screen you have open, select the screen in the Navigator > Select Close Selected
Forms.

s To close all screens, right-click anywhere in the Forms section > Select Close All Forms.

i
I

I

I

: W Task List

I

: Q  all Entities Search

i B [2] Homicide - John SMIT
I

I

I

I

I

I

I

Close form

Close all forms

Close Items You Have Open
There are different ways to close items you have open.
To close an item on the tab strip:

= Select the Close x icon on the tab.

= Right-click the tab > Select Close screen.

= Middle-click the tab.

To close an item from the Forms section:

1. Select the Show Forms B icon on the Navigator.
2. Right-click the item you want to close > Select Close Form.
To close all items you have open:
= Right-click anywhere in the Forms section > Select Close All Forms.

m  Right-click a tab on the tab strip > Select Close all screens.

x -x x
C 3K« R Q Anentiies searcn = B Foricde - 0mn surmH

I

I

I

!

! ]

! I

! ]

I Q .-

| All Entities Search Attributes Advanced Thesaurus  Scope :

I

] Close form ia 1

1 M| [2] Homicide - John 1
Close all forms alert Search

1 a

] use Keyword |~| [JAny words [ Show deleted :

e e —————————————_—E—_—_—_—_—_—_—_—_—_—_—_—_—_—_—_—_—_—_———_—————————— -
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Entity Trail Section
You can use the Entity Trail section to see the entities you have opened from an entity relationship.

Entities are listed under each branch in the order in which you opened them. There is a branch for each
active trail.

To access the entity trail section:

1. Select the Show Entity Trail B8 icon at the bottom of the Navigator.

2. Use the expand * and Contract - icons to hide or show items on the tree.

3. Use either of these methods to open an item listed in the Entity Trail section:
o Double-click the entity.
o Right-click the item > Select Edit Entity.

e e e e e e e e e e e e e e e e 1
| Entity Trail = ehicle 2 123456, Black car: Toyota Camri, AL, USA 1
. |
: - @ [2] Homicide - John SMITH & Vehicle [URN: 2] 1mages ECIT :
I 1] 4102346722
i g Details 1
1 [1] Call to ABC Electronics by " " 1
1 123456 United States Alabama Attributes [slEllCTy BT
| - Branch Reagistration #: 123456, Alabama, United States selected 1
1 # [3] ABC Electronics Salisbury | Classification: . .. 1
Open release: No Limited release: No Fictitious: No - Color 1
! @ [2] 123456, Black car: Toyota
1 Black :
: Limited releaze QEEEWGEIN Relationship summary History Involvements  Phase & LOE - condition 1
: [[] pisplay duplicate relationships =4 Good :
1 Relationship To URN Entity Start - Make :
: Garaged At (Garage Locatio 4 7 Smith's Grocers 123 High Street, B Toyota 1
1 Sighted At (Sighting For) N7 Smith's Grocers 123 High Street, B - Model 1
1 Recovered From (Recovery # 7 Smith's Grocers 123 High Street, B Camry :

Float or Dock a Section

You can display the Alerts, Favourites, Recent, Forms and Entity Trail sections as docked or docked
windows.

A floated section displays as an independent window. You can drag it outside of ICM to the required
position on your screen.

It's also possible to resize floating windows. If you prefer the Navigator sections sized and positioned a
certain way, you can save this layout.

When you next log on, the sections will display the way you last arranged them - See Preferences.
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Float a Section
Use either of these methods:
m  Select the Options Eiconin the logo section > Select the section you want to float.
s Select the Options B icon of the section you want to float > Select Float ....

To float all sections, select the Options Eliconin the logo section > Select Float All.

ﬂ }- Wiew Auc

) re
Jade e

Float Alerts
Entity Trail Float Favourites

Float Recent :
- Fawvourites Float Forms

B [15] Reg cert

Float Entity Trai

| = Favourites
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Dock a Section

Use either of these options to dock a floated section:
m  Select the Options Eiconin the logo section > Select the section you want to dock.
= Select the Close x icon on the floated section.

To dock all sections, select the Options E icon in the logo section > Select Dock All.

ﬂ ..ﬁ View Audit Entr:
Hide Mavigator
Eloat All
Dock All

Float Alerts
E 15
Float Recent '
Float Forms

” ; :/guided
Float Entity Trail et

1
A

I
I
I
I
I
I
I
I
A
I
I
I
I
I
I
I
I
I
I
I

|

|

|

|

|

|

|

|

|

|

|

|

|

|

|

:

: * [2014-1] Operation Hagley

| M [6] Theft of Vehicle

|
omicide - John

: M’ [2]H de - John SMITH

|

|

|

|

|

|

|

|

|

|

|

|

|

|

|

|

|

|

|

|

|

|

B [15] Reg cert

It

M| [7] Arson Report at 15 Reberts Lane, Adelaide
[2] Upload of PIN Register for 4103492232
[4] Evidence

[t¥

I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I

[34] Checking validity of suspect statements :
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
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Check Your Version of ICM

Select Help > About to see which version of ICM you're using.

You might need this information if you need technical help.

INVESTIGATIONS CASE MANAGEMENT

Version: 6.0.8 (Build 01)
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Write Yourself Notes

You can use the Notes section to write yourself notes. You can also copy, cut, and paste text to and from
this area.

It's also possible to save the contents of your Notes section when you log off so the content is available
again the next time you log on. See Preferences.

* Follow up on Case 43.
« Change Case Manager for
ase 29.

Redo
Undo

Cut

Copy
Paste
Find...
Replace...
Font...

Faragraph...
Bullet Style  »

Tab Strip

The area below the menu displays open screens as tabs.
You can select tabs to easily move between screens you have open.

A horizontal scroll bar appears in this area when you have several screens open.

: N All Case Types Search . 2 . =1 . Alerts |
: ase lypes searc ﬁ Homicide - John SMITH Data collection by covert inter € :
1
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Main Menu

The main menu has the following sections:

System See audit and file upload data. Exit or log off ICM
Incident reports See and manage incident reports

Information reports See and manage information reports

Cases See and manage cases

Tasks See and manage tasks

Property Manage assets, property, and equipment
Search Find entities

Noticeboard Run online bulletin boards for your organisation
Reporting Generate reports on investigation data

Admin Set up ICM to suit your needs

Help Get help with using ICM

The menu options available to you depend on your security permissions and the licences to features your
agency has purchased.

Menu options which are not available to you're either are “greyed out” or are not displayed at all.

Investigations Case Management [ Demonstration] - [Vehicle [URN: 2]] _

System Incident Reports Information Reports Cases Tasks Property Search HNoticeboard Reporting Administration Help & TECH DOCUMENTATION

ﬂ ado Theft

Call to ABC Electronics by Fre¢ “ ABC Electronics Salisbury 6 123456 United St%
———

I

|
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System Options

You can access the following options from the System menu:

Tools

Alerts Access a list of alerts

Triggers Set up notifications for certain actions taken in ICM

Watches Access a list of watches that have been placed on entities
Reminders Set up reminders for yourself or others

Active Searches See any active searches that have been set up

Stored Searches See search results that have been stored in ICM

Generic Diagram Create a diagram from entities you choose

Review List Review case notes and task results that are ready for approval
File Imports

File Definitions

Search Audits See Auditing Data in the Admin Guide
Data Expunging Review and remove data from ICM
Log Off Log out of ICM

Exit Close ICM

¥ Investigations Case Management [ Demonstration]

' System | Incident Reports Information Reports Ca

Tools Match And Merge (Manual)
Alerts Match And Merge (Auto)
Watches Import Data (XML)

Reminders Export Data (XML} r
Active Searches Import Case (from Laptop)

Stored Searches P
é, Police Inci

Generic Diagram 1 SMITH
Details
. Electronics by
Zle e Title
File Definitions
pnics Salisbury  Description
Search audits P
: ack car: Toyota
Data Expunging
Log Off
Exit

1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
i
1
Review List = !
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
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Manage Incident Reports
You can use the Incident Reports menu to find, create, and manage incident reports.

The following menu options are available:

Create Create an incident report using the templates your administrator
has set up

Search Find an incident report

Create From Word/PDF Create an incident report by uploading a PDF or Microsoft Word

Documents document to ICM

The Incident Reports menu will be available once your agency has configured incident
reports.

See Managing Entity Types in the Admin Guide.

i Investigations Case Management [Demonstration] - [Create incident rej

System '1m:'|dent Reports '| Information Reports Cases Tasks Property
doc unset incident

Police Incident Report

Motor Vehicle Claim

Search
Create From Word/PDF Documents

Information Report Options
You can use the Information Reports menu to find, create, and manage information reports.
The following menu options are available:

Create Create an information report using the templates your
administrator has set up

Search Find an information report
Create From Word/PDF Create an incident report by uploading a PDF or Microsoft Word
Documents document to ICM

The Information Reports menu will be available once your agency has configured these
reports.

See Managing Entity Types in the Admin Guide.

@ Investigations Case Management [Demonstration] - [Create incident reports from Word

System Incident Reports | Information Reports | Cases Tasks Property Search Hotic
Information Report

Search b Autopsy Report

Create From Word/PDF Documents
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Manage Cases

You can use the cases menu to create, manage, and find cases:

Create Create a case file or document using the templates set up by your
administrator

Search Search for a case or document

Case Summary See a list of cases. Filter the list according to case officer, date, and more

Resource See a list of the resources assigned to cases

Summary

1

1

1

I 1

I 1

i Search C A
1

I 1

I 1

I 1

I 1

I 1

Case Summary
Resource Summary |
e e e e e — ———————— — —— a

Manage Tasks

You can use the Tasks menu to manage your tasks and find tasks you're interested in.

The following menu options are available:
List See tasks that have been sent to you, assigned to you, or created by you.

Summary See a list of outstanding tasks. Filter the list by recipient, priority, and more.

incident rep:
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Manage Property Items

The Property menu provides these options:

Create Create reports about property items.
Search Find property reports.
Activities Record the activities of property items.

Whether they have been moved to a new location, for example.

Reporting Run reports on property items.

[Task List]
Tasks 'Eropert\r Search HNoticeboard Reporting Administration

|

|

|

|

:

i )
i Drug Seizure Report
[}

[}

[}

I

[}

|

|

|

Eraud Report
Activities  » Homicide Evidence Report
Reporting  » Drug Warrrant Seizure Report
e 4
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Access Search Options

You can use the Search menu to find any type of entity.

The following types of search functions are available:

URN Search Search for an entity using its Unique Reference Number (URN)
All Entities Search all entities

Cases Search all or specific types of cases

Case notes Search all or specific types of case notes

Entity Search all or specific types of entities

Incident reports Search all or specific types of incident reports

Information Search all or specific types of information reports
reports

Tasks Search all or specific types of tasks

Task results Search all or specific types of task results
Property Search all or specific types of entities
Management

Related Entities Search for entities that are related to each other

Entity The Entity Relationship Path (ERP) search is a powerful search that finds all
Relationship Path the connections between entities

You can combine most of these search options with an Advanced, Thesaurus, or Scope
search.

See Searching.

e T —————

Search | Noticeboard Reporting Administration Help & TECH DOCUM
URM Search

=
All Entities EcOUrce Summary a Task Summ

All Case Types

Case Notes 4 Case File

Entity 4 case test

Incdent Reports > Al Documentaton

e e B omode e

Task Results L i

Property Management  p | i
I

Related Entities |
|
I
I

Entity Relationship Path
= Additinnal detail
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Noticeboard
The Noticeboard menu provides an online dashboard for your organisation. It's like a bulletin board.
You can use it to communicate general updates, news about an operation, and more.

See the Noticeboard section.

|l

I obog o

I

| :

v [ Tem |EETETTTRCTE :

i My Postings Global » i
1

Reporting Options

You can use the Reporting menu to:
= Run reports on the data collected in ICM.
= Export bookmarked Word reports.

For more details, see the Reports section.

Reporting | Administration

Word Reports
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Access Admin Options
The Admin menu is only available to administrators.

They can use it to set up the following sections of ICM to suit your organisation:

System Set up system parameters, background apps, Lucene search, time zones, licence
key, thesaurus, translatable strings, and words to be excluded from searches.

Security Specify data and functional access for all roles, designations, teams, and users.
Specify security levels for business units and regions.

Entity Specify the entity types for your business process and the relationships those
Definition  |entities have.

Code Define the codes and values associated with application entities.
Tables

Templates |Define the templates to be used for adding data to your source entities.

XML Manage the way duplicate entries are handled.
Schema

See the Admin Guide.

| Administration | Help TECH DOCUMENTATION

! @

] System Configuration  p !
I

: Security b :
I " = 1
[ evmoctnion  J| 0 ;
i Code Tables b Categories :
i Iemplateg b Attributes i

Learn More about ICM

You can use this menu to access help content and see which version of ICM you're running.

See Download the Latest Help File.

'Help | & TECH DOCUMENTATION {

Index

About
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Right-click to Access Options Relevant to an Area

You can right-click several areas of ICM to access menus that apply to the area you're in.

For example, you can right-click the Recent section of the navigator to access functions that apply to that
area, like the option to add a recent item to your list of favourites.

I I
I I
! ; i
I+ B Case File ﬁ Case FI|E=
i + M Homicide File Edit Entity i
I+ F ic Not !
: orensic Mote Re Selected :
-
: + B General Case N Remaove All :
| + B Research/ Anal : : |
I o , Add To Favourites I
L+ 2 Surveillance Actreey J'

Access More Options from the Overflow Tab

When you open an entity, you can use the Overflow == tab to access additional options. These vary
depending on the entity you open.

T T e e e e e e e e e |
Contents  Entities  Access Threads  Disclosure Dissemination ||==
Outlook
Diagram Search within
Selected History
Watches

- Case Status (*)

Referenced Cases
- Open (24/04/2014) - _
[E] Closed (24/04/2014 09:34 - 24/0 Administration
o=e . -
Case Closure

[E] open (10/04/2014 10:34 - 24/04,

[E) Closed (25/09/2007 03:35 - 10/0

[Z) Active (06/08/2007 01:18 - 25/0
- Case Priority (*)

Reopen Case

Disclosure Bulk Sign Off
Storage Locations

. Images
High )
isk A t(C ity Impact) (*) Dslagm;am
- R
1= SEEEEMEen ommunity Lmpa IE map
- Likelihood
Eossible Extract Report (Word ;’emplate)
Run Entity-Based W
- Conseguence ty- ord Report
Bxtract documents and images
Moderate Export (for laptap)
- Activity Type (*) (+) P
_ MNoticeboard
Homicide
- Case Assignment Details Load from Word Document

View Word Document

- Team Assigned (+)
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Common Controls for Editing Items

When you open an item, you can use the following controls to enter information about it:

Display- Grey text indicates you can't change values in these fields.
only Fields
Mandatory  You must enter information in these fields.
Fields A red square at the upper left corner indicates that a field is mandatory.
Checkbox When selected, this field displays a Check mark v icon.
Checkboxes are often displayed in groups, providing you with multiple choices
from which you can select one or more options.
Drop-downs |A drop-down displays the currently selected item.
Additional options are available when you select the drop-down button.
To use a drop-down, select the down arrow ¥ beside the field > Select a value.
If the drop-down allows text entry, you can enter data into the field.
This type of drop-down is also known as a drop-down.
List box A field with a list of items you can select.
Option or An option or radio button displays an option that can be switched on or off.

radio button

You can only select one of the options available.

Field A field displays information from the database or information you have entered.
Date field These are indicated by forward slash characters that separate the day, month,
and year (dd/mm/yyyy).
You can enter text directly into these fields or select their Calendar H icons to
specify the required date.
See Enter a Date.
Time field These are indicated by a colon : character to divide the hours from the minutes,
for example, 23:45.
See Enter a Time.
Icons These are used to represent entities on screens.

Investigations Case Management User Guide

The way an icon looks can change, depending on the context in which you see it.

If the icon is for an entity you can move to another location, it displays a plus +
symbol at the upper right when you drag the entity to its new location.

See a table outlining the icons used.

Your administrator can configure different icons under the Icons tab of the entity
type.
See Defining an Icon for an Entity Type in the Admin Guide.
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Edit Text

You can cut, copy, format, and find text in most items you open.

To access these functions, right-click the text you want to edit.

- Information Report 8
ﬁl P

! I
! !
| 1
| Details i
! 1
I . .
I Title Theft of Vehicle |
I i :
: Drescription Wehicle reg FRD342 White Toyota Camry stolen from 23 Kings Street,:
! Owner EL” — 't by phone to Rangiora Police. 1
i Redo :
i Undo |
1 I
: Cut |
I
i Copy i
: Faste i
1 I
! Find... i
i Replace... !
I
i Font... !
| Faragraph... i
i Bullet Style + MNone :
| Dot i
i Mumber .
| Lowercase Letter i
i Uppercase Letter .
| Lowercase Roman Mumeral i
i Uppercase Roman Mumeral .
|
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Format Text

On some screens, you can format the way text displays once you have entered it in a field.

For example, you can change the text size, colour, and font, or create a bullet list to make the
information easier to read.

To access these options:
1. Select the word, sentence, or paragraph you want to format.
2. To change font, size, style, and colour:
a. Right-click the selected text > Select Font.
b. Make the required changes > Select OK.
3. To change indentation and alignment:
a. Right-click the selected text > Select Paragraph.

b. Inthe Left, Right, and First line field, enter the number of points by which to indent the left
margin, right margin, or first line of a paragraph.

c. Inthe Alignment drop-down, select the required alignment for the selected paragraph.
d. Select OK.
4. To convert selected text to a bulleted list:
a. Right-click the selected text > Select Bullet Style.
b. Select the required type of bullet list > Select OK.

o e B e e e e e e e e e e e e e T
[}
- . 1
:ﬂ Case File [URN: 2] :
[}
| Details !
[}
- 1
: Case officer DOCUMENTATION, Tech (JIDOC) - :
| Title [Homicide - Jahn SMITH :
[} . .
: Descriptian Subject Details :
1
[}
1 Name: John SMITH :
[} DOB: 01/05/1970 |
: Address: 27 Tonkins Street Ocean City Maryland 21842 1
| Contact Mo: (H) unknown (Cell) unknown :
[}
: Location of Incident: Secrets Nightclub - 3222 Jamison Street Ocean City Maryland 21842 :
: Details of Incident Select font ® :
[}
- I
: On the evening of 4 August 20 I
| Maryland. John Smith was shol[lks Fort style: |
1 and aramedics arrived at the |Verdana Bold :
| ————————————————
- . [l
: 4 glock pistol and a number offlVerdana ~ |Regular I
: as exhibits: Ref MA-Cen- 101.|ITPTrS 11'—;4,;”{ ITe Italic :
1 Other Relevant Informatior |-V Bold :
| ] _ Eltecomar Songer Bold Italic I
| Witness Details: Jane Evans off Webdi I
| Suspect Description (as provid ebdings e :
[}
[l
: Effects Sample I
[l
| I~ Strikeout I
AaBbYyZz I
: [ Underine o :
: Colar: I
! I E=ck ~| | Senpt: i
: |‘.".|'estem ﬂ I
1 [l
[l
[}
[l
[}
Ul
e a
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Find Words on a Page
When you open an area of ICM like a report, you can find words or phrases in the text.
To find a word or phrase in a body of text:
1. Right-click in the body of text you want to search > Select Find.
2. Enter the text you want to find in the Find what field.
3. If upper case or lower case is important for the search, select the Match case checkbox.
4

If you want the search limited to the exact search term specified, select the Whole words only
checkbox.

This will return results for Adams but not Adamson, for example.

5. To specify the direction for the search relative to the position of your cursor, select the Up or
Down radio button.

6. Select Find Next.

If the search finds an instance of the search text, the first instance of that word will be highlighted
in blue.

'ﬁ.. Autopsy Report AUT-2014-1

Details

Title .J!‘Lutu:q:rs,\),-r Report on John Smith

Description AUTOPSY REPORT 10-07645
I performed an autopsy on the body of Green, David at the DFF
COROMER on January 27th . |
Fram the anatomic findings and pertinent history, I ascribe the o
EXTERMNAL EXAMINATION: I
The body is that of a well nourished Caucasian male stated to I:hI
pounds, measuring 72 inches from crown to sole. The hair an th
irides appear blue with the pupils fixed and dilated. The m:
with no evidence of petechial hemorrhages on either. Both uppe:

Find what |sclerae

Search
[] Match case
O up Cancel 1

ml
® Down [ ] whole words only i
i
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Replace Text
You can replace a word or phrase in a body of text:
1. Right-click in the body of text > Select Replace.
2. Enter the text you want to find in the Find what field.
3. Enter the replacement text in the Replace with field.
4. If upper case or lower case is important for the search, select the Match case checkbox.
5

If you want the search limited to the exact search term specified, select the Whole words only
checkbox.

This will return results for Adams but not Adamson, for example.

6. To specify the direction for the search relative to the position of your cursor, select the Up or
Down radio button.

7. Select Find Next.

If the search finds an instance of the search text, the first instance of that word will be highlighted
in blue.

8. Select Replace to replace the selected text or Replace All to replace all instances of the text.

:Details 1
| |
Title .Autupsy Report on John Smith :

1

Description AUTOPSY REPORT 10-07645 i

I performed an autopsy on the body of Green, David at the OFFICE OF THE CHRISTCHL:
COROMNER on January 27th . |
From the anatomic findings and pertinent history, I ascribe the death to: MULTIPLE STAE:
EXTERMNAL EXAMINATION: 1
The body is that of a well nourished Caucasian male stated to be 35 vears old. The bl:llj'!:
pounds, measuring 72 inches from crown to sole. The hair on the scalp is white and stral
irides apoear bhlie with the nonile fived and dilated _The eclaras and condunctive gre |_||-|r:
there am :
There ar 1
Rigor mq :
Identifici Find what |approximately Find Meaxt :ific:atiu:nn:
iz not en |
The hea| Replace with |about Replace The nec
chest, ar v injurie
describe ence u:uf:
CLOTHIP Search i
The cloth Oup [] Match case ecedent]
wearing
EVIDENC ® Down [] Whole words only
DESCRII
1. Stab v ,
The stab) of the hi
inches from the front of the body; it is vertically oriented and after approximation of thE:
measures 5/8 inch in length. Inferiarly there is a squared off or dull end ElssaaEl=0y |
length; superiarly the wound is tapered. !

Replace all

Cancel
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Entering Dates and Times

It's not always possible to know the exact date or time an event occurred.

ICM caters for this by providing date and time controls that can accommodate:

Unknown dates or | These are labelled Unknown in the appropriate control.

times

Exact dates and These are represented by a single date or time.

times For example, 17/3/2004 or 15:36.

Continuous date The first and last value in a continuous range are separated by a hyphen.

or time ranges For example, 10/3/2004 to 17/3/2004 is represented as 10/3/2004-

17/3/2004 and the time range 06:00 to 10:00 is represented as 06:00-

10:00.
Discontinuous The first and last value in a discontinuous range are separated by an
date or time approximation ~ symbol.

ranges For example, 10/3/2004, 12/3/2004, 16/3/2004, 17/3/2004 is represented

as 10/3/2004~17/3/2004.
The time range 06:00, 08:00, 10:00 is represented as 06:00~10:00.
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Enter a Date
You can enter a date directly in the field provided or use the Calendar B icon to do this.

Dates are formatted according to your location. For example, if you're in New Zealand, the date is
formatted dd/mm/yyyy.

Some date fields only accept an exact date. This is to make it clear when action was taken.

The When actioned field on an incident report is an example of this. Other date fields accept exact,
unknown, continuous, and discontinuous date ranges.

To enter a date using the calendar tool:
1. Select the Calendar B icon beside the date field.

Days are colour-coded:

o Light blue - Days you can select.

o Dark blue - Days you can't select.
Dates are unavailable for selection when:
— They don't exist
— Arein the future

— They are not allowed in the context of the date you're entering (for example, a future
crime scene)

o Yellow - Dates you have selected.
2. Select the required date using any of these methods:
o Double-click the required date on the calendar.
o Use the Shift and Ctrl keys to select more than one date.
o Use the month and year drop-downs to specify the month and year > Select OK.

3. If you don't know the date and it isn't required, use any of these methods to specify that the date
is unknown:

o Select Unknown on the calendar screen.

o Enter Unknown in the date field.
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o Select Ctrl + U.

Actioned * fthe !

& |april | |2015 |- pid, @l

Mon | Tue |Wed | Thu | Fri | Sat | Sun | | Rig)
1
1 5 3 r 5 iLIE,EI

B 7 8 9 10 J11 |12

13 14 |15 |18 |17 |18 |19 ultif
- I

= (200 |21 |22 |23 |24 |25 |26

“lasd Clear Ok

1
1
1
1
1
1
1
1
27 |28 |29 |[=0 !
1
1
1
1
1
1
(|
(|
1
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Enter a Time
You can enter time directly into a time field or use the time scale screen to do this.
Times are displayed in 24-hour clock format — hh:mm.

Some time fields only accept an exact time. Other time fields accept exact, unknown, continuous, and
discontinuous time ranges.

To enter time using the time scale screen:
1. Select the Clock ® icon beside the time field.
The Time Scale screen displays a 24-hour period.
Each hour is divided into two half-hour slots.

Time displays from midnight b default.

You can use the arrowl icon to change this to midday if required.
2. Select the required time using either any of these methods:

o Double-click a time slot on the time scale screen.

o Select the required time slot on the screen.

Your selection is highlighted in yellow.
Use the Shift or Ctrl keys to select more than one hour or half-hour time slot.

3. Drag the slider to specify a more accurate time (if required).
4. Select OK.

Actioned % |

EIEI Dl I:IZ I:IB I:I4 I:IE I:IE EIJ‘ I:IB D'EI 11 12

12 20 21 22 23 24

Ié

30 02:30 39

Clear Ok
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Tips and Tricks
Access the Legend to See What the Colours Mean

Various areas of ICM use colours to make it easier to absorb information.

To see what the colours represent, right-click the area > Select Show Legend.

ﬁ Case File [URN: 2] Details m

Contents

i« Pinned Threads Tasks Property Reports FProperty Items Phases Lines of Enquiry

URN = Reported Date » Time Key Type # Title

8 11/07/2017 15:40 i 0  Red hair folicle found

2017/1 10/07/2017 11:25 A Burglary

38 05/09/2016 09:53 ] 0 Collect membership file from CFI (Mot sent)
35 10/08/2015 - mes Kite

24 02/04/2014 . b O hi
104/ |:| Introduced source entity Y wnersip

23 02/04/2014 | d .

1 12/03/2014 |:| Deleted source entity te

5 12/03/2014 |:| Criginating incident ar information report Report - 1 Smith

17 16/03/2010 11:11 0 Interim: xcgbb

2010/1 12/01/2010 13:15 A 0 will this be # 117
=, 1
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See Which Keyboard Shortcuts Are Available

You can use keyboard shortcuts to perform most functions in ICM.
For example, you can use the Shift or Ctrl key to select more than one entity at a time.

The following keyboard shortcuts are available:

Alt + letter Display the menu item with the underscored letter. For example,
Alt+S displays the System menu.

Alt+E Display the Search menu.

Alt+A Display the Admin menu.

Alt+R Display the Reporting menu.

Alt+F4 Close ICM.

Alt + Shift + right — or
left < arrow

Alt + Shift + up Tor down
larrow

Alt + right — or left <
arrow

Alt + up Tor down larrow

Open or close vertical panes, like additional details.

Open or close horizontal panes, like additional criteria in search
screens.

Add a current entry from an available list or remove an entry from
the selected list.

Move the selected entry up or down in lists that support

reordering.
Ctri+C Copy the selected text to the clipboard.
Ctrl + F Find something in a case.

Ctrl+F6or Ctrl+Tab

Cycle through screens you have open.

Ctrl + N Create something new.

Ctrl+S Save an entity you have open (if the Save button is enabled).
Ctrl + T Enter date or time in a field.

Ctrl + U Enter Unknown in a date or time field.

Ctrl+V Copy clipboard text to the cursor position or selected text.
Ctri+X Cut the selected text and place it on the clipboard.
Ctrl+Y Redo your last action.

Ctri+2 Undo your last action.

Ctrl +0 Hide or show the Navigator.

Ctrl + 1 Show the Alerts pane.

Ctrl + 2 Show the Favourites pane.

Ctrl + 3 Show the Recent pane.

Ctrl + 4 Show the Forms pane.

Ctrl + 5 Show the Entity Trail pane.

Investigations Case Management User Guide
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Ctrl + Shift + 1
Ctrl + Shift + 2
Ctrl + Shift + 3
Ctrl + Shift + 4
Ctrl + Shift + 5
Ctrl + 6

Ctrl + Shift + 6
Ctrl + PgDn
Ctrl + PgUp
Ctrl + 7

Ctrl + Tab or
Ctrl + Shift + Tab
Ctrl + Shift + A

Ctrl + Shift + C
Ctrl + Shift + D
Ctrl + Shift + E
Ctrl + Shift + W
Ctrl + Shift + ?

Ctrl + up Tor down |
arrow

Ctrl + Delete
Esc

F5

Tab

Up Tarrow
Down larrow
Left < arrow

Right — arrow

44

Float or dock the Alerts pane.
Float or dock the Favourites pane.
Float or dock the Recent pane.
Float or dock the Forms pane.
Float or dock the Entity Trail pane.

Swap to the next or previous tab in the current screen.

Open the Overflow == tab.

Swap to the next or previous screen you have open.

Toggle the visibility of the available attributes list when you edit
an entity.

Go to the Contents tab of the case you have open.
Go to the Details tab of the entity you have open.
Go to the Entities tab of the entity you have open.
Jump to the Watches tab in when editing an entity.
Open the keyboard shortcuts screen.

Insert an entry above or below the selected entry in lists that
support inserting.

Delete the selected entry in lists that support deleting.
Close the screen you're looking at.

Refresh the content on a screen you have open (like the contents
of a case, for example).

Move between controls on a screen.

Move the cursor up the selected screen.

Move the cursor down the selected screen or pane.
Move the cursor left of the selected screen.

Move the cursor right of the selected screen.
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Preferences

You can customise the way you use ICM. This section explains the options available.

Save window size and position
Save navigator section states
Save notes content on log off

Confirm on exit

°OrO0O0

Mumber of recent entities to keep

[y

Creator automatically added to new case

Creator automatically added to new incident report
Creator automatically added to new information report
Creator automatically added to new asset report
Creator automatically added to new equipment report
Creator automatically added to new property report
Case contents - most recent first

Alert when assigned as case officer

Hide source entity template prompt
Confirm attribute deletion
Spellchecker Spellchecker is not installed on this computer

EE|  OEREEEEEO

[
1]

COwverride language for initiating Excel -

Diagram

Use identification images for entity nodes

Use images for image nodes

Use low resclution

Colour to use for deleted elements on diagram

Colour to use for relationship text on diagram

OEECO0
G|

Colour to use for multiple relationships on diagram

Font to use for node captions on diagram 0.00 !

Font to use for relationship captions on diagram 0.00 !

Task diversion (Recipient/&uthoriser/Reviewer) Task reminders

To user - First reminder 1 | days before completion date

Resume date A Second reminder | 1 | days before completion date
gy gy U U |
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Customise your Display

You can customise the way you see information in ICM:
1. Select your User ID on the main menu > Select Preferences.
2. Select the required options:

o Save default window state if you want the current window state (normal or maximised)
retained when you reopen ICM.

o Save window size and position if you want the current window size and position retained
when you reopen ICM.

o Reset window size and position to default to restore the default window sizing for ICM.

o Save navigator section states to restore the current pane size and position of the
Navigator when you reopen ICM.

o Save navigator width to save the width of the navigator when you close ICM

o Save notes content on log off if you want the contents of the Notes section retained when
you reopen ICM.

o Confirm on exit if you want a confirmation screen to display before you exit or log off ICM.

3. Change the default number in the Number of recent entities to keep field to specify the
maximum number of entities you want displayed in the Recent section of the Navigator.

4. Select Save.

Save window size and position
Save navigator =ection states
Save navigator width

Sawve notes content on log off

Confirm on exit

2 O0EEOOO

Mumber of recent entities to keep

[y
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Have the Creator Automatically Added to a New Case or Report

1. Select your User ID on the main menu.

2. Select the required options:

o

Creator automatically added to new case to be added to the security access list of each
case you create.

Creator automatically added to new incident report to be added to the access list of
each incident report you create.

Creator automatically added to new information report to be added to the access list
of each information report you create.

Creator automatically added to new asset report to be added to the access list of each
new asset report you create.

Creator automatically added to new equipment report to be added to the access list of
each new equipment report you create.

Creator automatically added to new property report to be added to the access list of
each new property report you create.

Case contents - most recent first.

Select Alert when assigned as case officer if you want to be notified when someone
makes you the case officer of a case.

3. Select Save.

Creator automatically added to new case

Creator automatically added to new incident report
Creator automatically added to new information report

Creator automatically added to new equipment repart
Creator automatically added to new property report
Case contents - most recent first

Creator automatically added to new asset report

Alert when assigned as case officer
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Access Language and General Options
The following language and general options are available:

1. Select your User ID > Select Preferences.

2. Select the required options:

o Select Hide source entity template prompt to disable the prompt for a template on data
entry for source entities (cases and case notes, for example).

o Select Confirm attribute deletion to display a confirmation message when you delete an
attribute from an entity.

o Select Override language for initiating Excel to specify the language Excel will use when
you export data.

The language you choose must be recognized by your installation of Excel.

3. Select Save.

[Hide source entity template prompt L1 T TTTTTTTTT 1

L
| Confirm attribute deletion
! se spellchecker Spellchecker i= not installed on this computer

1 . e
:_Dverrlde language for initiating Excel
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Customise the Way You Use Diagrams

1. Select your User ID on the main menu > Select Preferences.
2. Navigate to the Diagram section.
3. Select the required options:

o Use identification images for nodes to use identification images for nodes when using the
Diagram Options screen.

o  Use images for image nodes if you want to use images for image nodes when using the
Diagram Options screen.

o Use low resolution to improve performance.

4. Select Browse beside Colour to use for deleted elements on diagram > Find and select the
default colour for deleted elements.

5. Select Browse beside Colour to use for relationship text on diagram > Find and select the
default colour for relationship text.

6. Select Browse beside Colour to use for multiple relationships on diagram > Find and
select the default colour for multiple relationships.

7. Select Browse beside Font to use for node captions on diagram > Find and select the
default font for node captions.

8. Select Browse beside Font to use for relationship captions on diagram > Find and select
the default font for relationship captions.
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9. Select Save.

Diagram

Use identification images for nodes |

Usze images for image nodes [

Use low resolution O

Colour to use for deleted elements on diagram . !

Colour to use for relationship text on diagram . !

Colour to use for multiple relationships on diagram |:| !

Font to use for node captions on diagram Tahoma 9.75 ! »

Font to use for relationship captions on diagram mhoma q.75 !

sk reminders
Color

r=t reminder 1 | days befors

Basic colors: .
scond reminder | 1 | days beford
Custom colors: ‘

Hue:[160  Red:[0
Sat: Iﬁ Green: ID_
| ColorISohd m:[120  Blue: [255

QK | Cancel | Add to Custom Caolors |

EEEENET
EEEN T
HEEET
EEEENN
T HAENEN
EEEENT
THEENET

Access Task Options

You can set up reminders about tasks.

If you go on holiday you can divert your tasks to someone else while you're away.
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See What You Have Permission to Access

Your administrator will assign you to relevant teams and roles, and give you the required permissions
and designations.

1. Select System > User Preferences or select your User ID on the main menu.

2. Select the User Details tab.
________________________________________________________________________ 1

-
I
: User Preferences Preferences User Details

I

I
1 1
| Teams Designations :
: All Users 1
| | Executive :
: Investigation Team 1 1
| |Investigation Team 2 :
| |Investigation Team 3 |
: Surveillance Operative 1

I
| I
1 I
1 I
1 I
1 I
1 I
1 I
1 I
1 I
1 I
1 |
| Roles Permissions :
: Access - All User + General Permissions “1
| |Administrators - IT - Incident reports :
: Administrators - Audit Can change attribute history date/time 1
| |Administrators - Exper Can add security access :
[IIFull Access Can remove USer access |
e e -

Add Information in ICM - Example Workflow

The way you enter data in ICM also depends on your agency’s business processes.
The process described here provides an example of how you could enter information in ICM:
1. Create a case - This is usually the first step in an investigation.
A case is an investigation file.

2. Convert to case - If you don't create a case directly you can convert a source entity (like a task,
information report, or incident report) to a case.

3. Create a source entity — This is how you record all information that relates to an investigation.
You can create a source entity manually or by importing a Word document.

4. Add an entity — Add information about an entity (like an image, person, or address) to a source
entity.

Create and record a task for an investigation.
6. Create and record a task result for an investigation.

Gather information — Use the search and diagram tools to analyse information that relates to the
investigation.

8. Close a case - This happens when you're finished with an investigation.

When you close a case, its source entities are still accessible from other cases.
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NOTICEBOARDS

About Noticeboards

You can run online noticeboards for your organisation.
The noticeboard is like a bulletin board.
You can use it for:
=  General updates
= News about an operation
m Links to contacts, manuals, and policies
s Messages
You can:
m  Post messages to boards you have been subscribed to.
You can't change a post you have made but you can delete it.
= Load historical posts into a board.
= Search within a board.
Only users with the Noticeboard Administrator permission can create or edit noticeboards:
m  They can restrict subscription to a noticeboard.
This means only an administrator can add and remove users from the subscription list.
Users can't subscribe or unsubscribe to noticeboards themselves.

m  Usersin ateam, or users with access to a case, are automatically subscribed to Team and Case
noticeboards.

If a user is removed from a case or team, and they have posts in that case or team noticeboard
that haven't been reviewed, those posts will be marked as reviewed when the user is removed
from the case or team.
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Post a Comment from a Case

1
2
3.
4

Open a case.
Select the Overflow == tab > Select Noticeboard.
Enter your post in the New Message area.

To make your post more noticeable, select the Urgent checkbox.

New message IE| Urgent

Suspect spotted in MacDonalds car park

Select Post.
If you marked your post as urgent, it will pop up in a window for other users to read.

.:o:. An urgent noticeboard post has been created as follows:

i
I

I

I

I

I

I

I

| Moticeboard: General Staff Motices
I

I

| Details: Please ensure you fill in your time recording before leaving for the day.
I

I

I

I

I

I

F—————— 1
Task: i

: asks Unread noticeboard posts 1

I
: New In Progress Overdue Rejected Type Date/Time Noticeboard Details :
1 1 1 Global 19/11/2018 16:04 General Staff Notices There will be a system outage 1
: Global 19/11/2018 15:59 General Staff Notices Fleaze ensure you fill in your t :
: eI For Auth Mare Detail Global 19/11/2018 16:01 General Staff Notices There will be a system outage |

I
I 0 ]
gy S 4
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Remove a Post

You can remove a post you have made.

You might want to do this if the post is incorrect or no longer relevant:
1. Select Noticeboard > My Postings.
2. Select the post you want to delete.
3. Select Delete.

Notice board posts Message
Date/Time Type MNotice Board This case is due for review.
15 July 2015, 11:54:21 Case [2014-1] Operation Hagley

24 April 2014, 10: 3 ¢ [2014-1] Operation Hagley

11 April 2014, 10:39:42 Team test to delete [deleted]

11 April 2014, 10:38:27 Team test to delete [deleted]

i1 April 2014, 10:00:34 Case [2014-1] Operation Hagley

11 April 2014, 09:39:01 Global Global Moticeboard

11 April 2014, 09:29:07 Global Global Moticeboard

11 April 2014, 09:14:13 Global Global Moticeboard

07 April 2014, 12:42:47 Case [2014-1] Operation Hagley

07 April 2014, 12:42:09 Case [2014-1] Operation Hagley

07 April 2014, 12:41:01 Case [2014-1] Operation Hagley

04 April 2014, 14:07:41 Case [2014-1] Operation Hagley

04 April 2014, 14:03:00 Team Surveillance Operatives

04 April 2014, 13:59:44 Team Surveillance Operatives

04 April 2014, 13:51:41 Case [2] Homicide - John SMITH

See Unread Noticeboard Posts

It's easy to see which posts on the noticeboard haven't been read.

e e e e 1
[} ;
] Tasks IUnread noticeboard posts I :
[}
1

: New In Progress Owverdue Rejected Type Date/Time Moticeboard Details :
[} Gl 1179 ~ - S - " anpe

Global 19/11/2018 16:04 General Staff MNotices There will be a systemn outage |
i 0 1 1 0 | em outage |
| Global 19/11/2018 15:59  General Staff MNotices Flease ensure you fill in your t :

vigw A i oba : enera a otices ere will be a system outage

| R IR R Global 19/11/2018 16:01 G | Staff Not Th Il b t tage |
I 0 0 0 :
[}
1 Recent noticeboard posts C = :
: Task results 1
1 Type Date/Time Noticeboard Detail=s :
[} o N : . .
| For Review Accepted Rejected Global 19/11/2018 16:01 General Staff Notices There will be a system outage :
[} . . .
1 eam : urveillance Operatives uspect spotted in red mazda

T 19/11/2018 16:00 5 Il o t 5 ct tted d d :
S -
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Search for a Post in a Noticeboard

1. Select Noticeboard > View > Select the noticeboard you want to search in.
2. Use either of these methods to access the search:

o Right-click in the list of messages > Select Search Within.

o Select the Options = icon > Select Search Within.

Enter your search words in the field provided > Select Search.

4. Select a post to display more details about it.

[}
1 .
IQ Global Noticeboard Search

I -
Enter criteria below

I
I
I
I
I

Search words | cake :
[ Any words Clear |

I

Results (1) Additional detail 3 :
I

I

I

|

[}
[}
[}
[}
[}
[}
[}
: DOCUMENTATION, Tech (JIDOC)
[}

[}

DOCUMENTATION, Tech (JIDOC) 24 August 2017, 11:47:20 Cake in the kitchen downstairs 24 August 2017, 11:47:20
Cake in the kitchen downstairs

See Historical Posts

Sometimes it is useful to see noticeboard posts from the past.
You can use ICM to quickly find posts made on a particular day:
1. Open the required noticeboard.
2. Use either of these options to see historical posts:
o Right-click in the Number of messages area > Select Load Historical Posts.
o Select the Options = icon > Select Load Historical Posts.
3. Select the required date > Select OK.

a Global Noticeboard Noticeboard

Number of messages: 4

1 I
1 I
1 I
1 1
1 I
’ :
i | 24 August 2017, 11:47:20 - DOCUMENTATION, Tech (JIDOC) : i
: Calke in the kitchen downstairs = . :
1 I
1 I
1 I
1 I
1 I

11 April 2014, 09:39:01 - DOCUMENTATION, Tech (JIDOC) : Search Within
! Thanks for this - it looks quite comprehensive!
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Access to Noticeboards
Create a New Noticeboard

When someone creates a case or team, a corresponding noticeboard is created automatically.
Depending on your permission, you can also create your own noticeboard:
1. Select Noticeboard > Manage.
Select the New button.

2
3. Enter a description for the noticeboard in the field provided.
4

Notice Board Definition
Type Sloba
Description General Staff Motices

Deactivated O

Select Save.
M T TTTTTTTTTTTTTTTTTTT T T oI oTT T oTooTo oo oo oo oo T
:O Notice Board Manager :
! .
| Details :
[}
1 ) 1
| Filter type All :
[}
1
: Notice Boards = Additim:
[} L. >
| Type Description Subscrl:
[}
1
: Team All Users DocUME
: Team Executive
: Team Investigation Team 2
: Team Investigation Team 3
: Team Surveillance Operatives
: Global General Staff Notices
: Global Global Moticeboard
: Global IT Forensics Group
: Global Product Analysis for Competitive Intelligence
[}
[}
[}
: 1 ]
[}
[}
[}
[}
[}
[}
[}
[}
[}
[}
[}
[}
[}
[}
[}
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Deactivate a Noticeboard

You can deactivate a noticeboard to prevent people posting to it. Any user can deactivate any
noticeboard.

People can still subscribe to a deactivated noticeboard, but they won't see the board on the Noticeboard
menu.

1. Select Noticeboard > Manage.

2. Select the noticeboard you want to deactivate.
3. Select the Deactivated checkbox.
4

Select Save.
_________________________________________________ -l
n Notice Board Manager :
1
1
Details :
1
Filter type All i
1
Motice Boards :
1
Type Description :
Team All Users :
1
Team Executive :
Team Investigation Team 2 :
Team Investigation Team 3 :
1
Team Surveillance Operatives :
Global General Staff Notices !
Global Global Moticeboard
Global Product Analysis for Competitive Intelligence

1

Motice Board Definition
Type Globa
Description Global Noticeboard

i
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
:
: Global IT Forensics Group
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I

! IDeac.'tivatEd
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Reactivate a Noticeboard

Any user can reactivate any noticeboard that has been deactivated.

Doing this returns the noticeboard to the Noticeboard menu for subscribed users.
1. Select Noticeboard > Manage.

2. To see which boards are deactivated, right-click in the Noticeboards area > Select Show
Deactivated.

Select the noticeboard you want to reactivate.
4. Deselect the Deactivated checkbox.

Select Save.

° Notice Board Manager

Details
Filter type All

Motice Boards

Type Crescription

Team All Users

Team Executive

Team Investigation Team 1 [deactivated]

Team Investigation Team 2

Team Investigation Team 3

Team Surveillance Operatives

Global Global Noticeboard

Global IT Forensics Group

Global Product Analysis for Competitive Intelligence

1
Motice Board Definition
Type Team

Description

1
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
i
: Global General Staff Notices
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I

|DEE|E.'ti'u’E|tEE| |:|I
| |
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SOURCE ENTITIES

Source entities include information reports, incident reports, case notes, tasks, and task results.
You can use source entities to record information about an investigation. This is how data is added to ICM.
Once you have added data to source entities, you can:

»  Update the data.

For example, to change an information report associated with a case, you'll need to open the
information report and make the required changes.

s Convert an information or incident report to a case.
= Link a source entity to a case.

Your agency can customise the data required for each type of source entity. This includes whether a
template is used to enter information about a source entity.

Your agency can also specify the types of source entities that inherit the properties of basic source
entities. See Maintaining Entity Types in the Admin Guide.

Depending on your permission settings, you can edit source entities. See Data Entry in the Admin
Guide.
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Types of Source Entities
Cases

A case contains all the information that relates to an investigation.
Source entities like case notes, incident reports, and tasks are linked to cases.

Tangible entities like images and reports are attached to source entities.

= — 1
:ﬁ Case File 2 Contents ~ Entities ~ Access  Threads Disclosure Dissemination:
I i I
| Details |
: Case officer DOCUMENTATION, Tech (JIDOC) - LEGEWESN Diagram :
: Title [Homicide - John SMITH Selected :
: Description .Subject Details - Case Status (*) :
| - Open (24/04/2014) |
1 Name: John SMITH 24 . ]
! DoB: 01/05/1970 2] Closed (24/04/2014 09:34 - 24/04/2014 09:34) |
] Address: 27 Tonkins Street Ocean City Maryland 21842 m Open (10/04/2014 10:34 - 24/04/2014 09:33) 1
1 Contact Mo: (H) unknown (Cell) unknown 1
| [E) Closed (25/03/2007 03:35 - 10/04/2014 10:33) |
1 Location of Incident: Secrets Nightclub - 3222 Jamison Street Ocean Acti 06/08/2007 01:18 - 25/09,/2007 03:34 1
I City Maryland 21842 m ive (06/08/ ' /03/ 134) :
I - Case Priority (*)
: Details of Incident High :
: On the evening of 4 August 2007 at approximately 11:00 pm witnesses - Risk Assessment (Community Impact) (*) :
1 heard a number of gunshots which appeared to be discharged from the - Likelihood 1
1 back entrance of the Secrets Nightclub in Maryland. John Smith was shot on Likelihoo 1
1 the premises where he was seen to be exiting towards the carpark area. Possible 1
1 John sustained a gunshot wound to the head and was deceased when police 1
1 and paramedics arrived at the scene. - Consequence 1
] I
1 A glock pistol and a number of empty bullet rounds were recovered within Moderate 1
I arms reach of the deceased. The serial number on the pistol was - Activity Type (*) (+) 1
I ADS6789Z35A. These have been booked in as exhibits: Ref MA-Cen- 101. - 1
1 Homicide 1
: Other Relevant Information (Eg Witness Details etc) - Case Assignment Details :
1 Witness Details: Jane Evans of 45 West Street Ocean City Maryland 21842 - Team Assigned (+) 1
I
1 Suspect Description (as provided by the witness): White male wearing a Investigation Team 1 |
! balaclava / approx 5'11" / heavy build / Blue T-shirt, Black Leather Vest, g
L Jeans :

vestigations Case gement User Guide
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Incident Reports

Your agency might require incidents to be registered. You can use the Incident Reports feature in ICM for
this.

A recorded incident might escalate into a full investigation.

Investigations Case Management

An incident report that relates to more than one investigation can be linked to another investigation.

Title

Description

Draft
Crocument
Classification
When Actioned

When happened

.Burglary

.Suhject Details

Mame: John Smith

DOB: 28/05/1979

Address: Some address, somewhere
Contact No: (H) 123456 (Cell) 93765432
Location of Incident: 123 Smith street

Details of Incident

Multiple items taken from address
Other Relevant Inforamtion (for example, witness details)
Garden statues taken in particular

1.Alexis (Bronze, 160 cm’s, value $24,000)
2.Jumo (Stainless steel, 200 cm's high, value $15,000)

O

[31/12/2009 H

[31/12/2009 H

Investigations Case Management User Guide

Entities (0]
Attributes JEWER[E]

Selected

Access  Comments (0)

Recommendation (*)
To be Determined
Incident Type (*) (+)
[E. Break and Enter
Incident Location (*)
- Public
- Public Location {+)
Cther
Weapon Used (*)
Mo
Firearms Prezent at Scene (¥)
Mo
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Information Reports
An information report contains data from one source. It could include circumstances that might:
= Not be directly related to an investigation
s Still occur
= Have occurred
=  Warrant recording for future reference

= Have potential to be investigated on face value or in conjunction with other information

o e 1
| oM . 1
| ﬁl Information Report 8 Entities (1) Access  Comments (0) Tasks (1) Threads (*)
Details
Title ITheft of vehidle syl M=l Diagram
. Selected
Description Wehicle reg FRD342 White Toyota Camry stolen from 23 Kings Street, .
Woodend between the hours of 11pm and 6:30am 22/2/2014. Owner Grian - IR Status (*)
Smith reported theft by phone to Rangiora Police. - validated

- Validating Officer (+)
ADMINISTRATOR, Default Agency (DEFLTADMIN)

- IR Source (*)

General Public
- Activity Type (*) (+)

Vehicle Theft
- Admiralty Rating (*)
Draft O - Source Reliability

C - Fairly Reliable

Document L] Allow edit - Information Accuracy

Classification 2 - Probably True

When Actioned  |03/03/2014 iz 19:26 ¢ o
-

[[] Excluded
[ signed off for disclosure

Bulk entities sign off in this source Bulk sign off
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Case Notes

You can use a case note to record activities and information that relates to an investigation.
Case notes are used to add all information, documents, images, video, and other media to a case.

For more details, see Case Notes.

-
== .
‘ Forensic Note 5 Entities (0) Accesz  Tasks (0)

Details
tle Forensic Report - 1 Smith rhutes L=

Description .Fingerprint report showed prints on glasses matched those of Joseph Smith

Draft DRAFT

L d

EHECCR- WIS Review Disclosure

Phases [# = Lines of Enquiry =+

[}
[}
[}
[}
[}
[}
[}
[}
[}
[}
[}
[}
[}
[}
[}
[}
[}
[}
[}
[}
[}
[}
[}
[}
[}
[}
[}
[}
[}
[}
[}
[}
[}
[}
[}
[}
[}
[}
[}
[}
[}
[}
[}
[}
[}
[}
[}
[}
i
[}
: Undefined Undefined
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Tasks and Task Results

You can use tasks and task results to find and monitor tasks associated with a case.

A task can't exist independently. It must be created and associated with a source entity like a case, case
note, or incident report.

Tasks and task results are recorded in the case log.
To access the case log:

1. Open the case.

2. Select the Contents tab.

3. Select the Log subtab.

I - 1
E General Task 5 Submission Entities (0)
Details

Attributes [sERIEL
Status Complete Creator |DOCUMENTATION, Tec
) . - - Selected
Title [check tipped off location
Description [Check the lacation in the information report to verify whether Mark

Harrizon was there location

Classification
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Property Reports and Property Items

Property reports are usually associated with a case but can exist independently. The don't need to be
attached to a case.

For example, lost property might be recorded in a lost property report. These property items don't need
to be associated with a case or related to other property items in the report.

Property items are always associated with property reports. They can't exist independently. Similarly,
case notes can't exist without a case.

HME-201 893798732 Knife at scene Current location: Canterbury = Christchurch Central = Level 1 Exhibit Room = Compactus
CEN-LVL1-001 = Shelf CEN-LVL1-001-02

[ o o e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e o e o e o o o e o o o i e e e b
: X
1 Homicide Evidence Report 1-2014 Evidence :
: 1

1
] Homicide Evidence Report 1-2014 ; i . : !
: « P Details Entities (0) Items (1) Access  History Watches == |

1
: Items F= :
: URN Unique ID Title Continuities  Actions 1

1
! 1
! 1
! 1
! 1

Can Contain Ttems: No

Disclosure Items and Indexes

A disclosure item is a source entity that can be disclosed to the defence in a legislative prosecution
process. It's a container for disclosed documents.

There is one disclosure index for each defendant. Each disclosure index has several disclosure items
associated with it.
Brief of Evidence
A brief of evidence is a set of files containing:
» A narrative of the facts of an investigation
s Allegations
»  References to legislation regarding allegations
Examples of evidence include the:

= Defendant

. Witness
= Victim
= Offence

»  Element of proof

= Statement

= Exhibit

= Other disclosable

= Administrative document

Your agency can use the brief of evidence feature in ICM to prepare documents for court.

Investigations Case Management User Guide 6.0.8 -06/12/2018



Investigations Case Management

Source Entities 66

Source Entity Review Process

It's possible to make case notes, tasks, and task results subject to review before they are confirmed as
valid components of a case. If this has been set up, the review always takes place before authorisation.

Source entity review is optional. When you create a source entity, you can decide whether it needs to be
reviewed by another user. Your business process will usually determine whether you send a source entity
for review.

The review process has these steps:

1. The user who creates a source entity is the originator — The originator assigns the source entity
for review by another user (the reviewer).

2. The originator submits the source entity for review - This causes the source entity to appear on
the reviewer’s review list.

3. The reviewer selects and opens the source entity from their review list - They decide whether to
accept or reject the source entity.

4. The originator takes any required action about the source entity, like adding a task.

The flowchart shows how review states change for a source entity.

Investigations Case Management User Guide 6.0.8 -06/12/2018



Investigations Case Management

Source Entities 67

Mot Reviewed

Pending Review

Y

Qriginator Qriginator
clicks clicks
Submit Finalise

Reviewer Reviewer
clicks Reject clicks start
Review

Reviewer
clicks
Finalise

F 3
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Access to Source Entities

Security profiles control access to cases, incident reports, and information reports.
An Access tab is available on all source entity screens. It shows who can see and change a source entity.
The Selected field under the Access tab shows the designations, teams, and users who have access to

the selected source entity. Users with permission to remove security access can use the Selection
arrows to manage access.

The case officer for a case can edit the case and the case notes.
Some users and teams automatically have access to some source entity types. See Access by Default.

————— e e e e ——————————_—_—_—_—_——_—————_—_—_—_—_————_—_—_—_E—_E—_—_———_—_E—_—_E—_E—_—_—————_——_—_————————— 1
[}
- - 1
[} . i
1 é Police Incident Report 2009"{1 1 Details Entities (0) Comments (0) Tasks (0) Threads (0) :
[}
1
: Access :
[}
: ® Designations O Teams O users Q Selected :
1
: Commissioner - Teams 1
| Director Intelligence M
: Director Operations - Individual Users |
1 Director UC Operations # MASON, Robert (DEMO1) [Deactivated] :
: Supervisor # BRIAN, Clark (DEMOZ) :
: # DOCUMENTATION, Tech (JIDOC) H
3 # USER, Demo (110005) !
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Give Someone Access to a Source Entity
You can give another user access to a source entity if you have the Can add Security Access permission.
1. Open the case.
2. Select the Access tab.
3. Select the type of user:
o Designations
o Teams
o Users
o Case Teams

4. Select the designation, team, or user.

5. Use the Select icon to move the required users to the Selected area.
By default, the selected designation, team, or user has read-only access.
This is indicated by the View = icon.

6. To give a user full access, select the View o= icon.

It will change to an edit # icon.

You can only use the security access list of a case note if you have been given access to the case
note by the case officer of that case.

For more details, see Case Note Alert Options.

5 1
: ﬂ Case File [URN: 18] Details Contents  Entities Threads Disclosure:
[} 1
: Access :
: O Designations @ Teams O Users O Case Teams Q Selected :
: All Users {- Teams |
: Executive -| # Burveillance Operatives :
| |Inwestigation Team 1 X Cace Administrator ]
: Investigation Team 2 ' (Can maintain threads :
: Investigation Team 3 X Can update limited release :
[ ¥ Can review case notes [
: « (Can add security access :
I - Can remove security access I
: X Users :
: X Teams/Designations/Case teams :
1 + Disclosure ]
: + Case Notes :
1 + Information reports 1
e S R, d
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Revoke Access to a Source Entity
To revoke access to a source entity, you need one or both of these permission settings:
= Can remove security access users to remove access for users.

= Can remove security access Teams/Designations/case Teams to remove access for
teams, designations, and case teams.

To revoke access for a user, team, designation, or case team:
1. Open the required source entity.
2. Select the required user, team, designation, or case team in the Selected field > Select the
Deselect icon.
Select the expand * or Contract - icons to expand or contract a branch on the tree of users.

Details about managing security are available in the Admin Guide.

Investigation Team 2
Investigation Team 3
Surveillance Operatives >

[ e S S o s 1
[}
- - 1
: é Police Incident Rer"ort 2009;’1 1 Details Entities {0) Comments (0) Tasks (0) :
[}
1
: Access 1
1
[}
1 O Designations ® Teams O users Q Selected :
[}
: : 1
: All Users - Teams 1
: Executive .7 All Users :
1 Investigation Team 1 + Individual Users :
| I
1
! I
[}
1
! I
! I
! I
! I

Case Teams
A case team is specific to a case. You can use it to give a group of users access to a case.
This is useful if you have a group of users performing a particular role within a case.
For example, you might want to give photographers access to:
m  See general case notes.
m  Create or edit scene examination case notes.
Your administrator can set up default case teams and the rights associated with these.

The case officer can create case-specific teams.
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Add an Ad Hoc Case Team to a Case
1. Open the required case.

Select the Access tab.

Select the Case Teams option.

Select New.

Enter a name for the new team in the Description field.

o v & W N

Find the people for this team:

o Select the Users (default business unit) option to limit the list of users displayed.

o If there are several users, enter the first few letters of their name in the Search field.

o Select the Hide Team Members checkbox to hide users who are assigned to this case team.
You might want to do this if you're assigning covert users to this team.

For example, you might want to hide the identity of the person auditing the case.

7. Use the Select icon to add the selected user to the team.
8. Select Save.
The new team is added to the Selected field on the case.
They have View access by default.

i ﬁ Case File 2

Access

O Designations O Teams O Users ® Case Teams

Armourer

Description Green Team -
Search br Hide Team Members [

® all users O Users (default business unit, default busii Selected

Migration, (MIGRATE) ADMINISTRATOR, Default Agency (DEFLTADMIN)
ADMINISTRATOR, Default Agency (DEFLTADMIN

BOBSON, Johnny John (JI0006)

DENBY, Joe (JODOC)

DOCUMENTATION, Tech (JIDOC)

HAY, Greg (GREGH)

MCDONALD, Shirley [CNWSAS1) 3

THOMPSON, Greg (DEMO3)

USER, Demo (110005)

o
Assignees m Edit
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Edit a Case Team

1.

o un A W N

Open the required case.

Select the Access tab.

Select the case team you want to edit in the Access area.
Select Edit.

Use the Selection arrows to add or remove users.

Select Save.

Access

O Designations O Teams O Users & Case Teams

Armaurer

T B Maintain Case Team

Description Photographer
Search Hide Team Members [

O all users @ Users (default business unit, default busii Selected

-
! 1
! 1
! 1
! 1
! 1
! |
! |
! 1
! 1
! 1
! 1
! 1
! 1
! 1
! 1
! 1
: Migratian, (MIGRATE) BRIAN, Clark (DEMOZ) :
1 ADMINISTRATOR, Default Agency (DEFLTADMIN) |
: BOBSON, Johnny John (JI0006) :
: BRIAN, Clark (DEMD2) 1
1 DENEY, Joe (JODOC) !
: DOCUMENTATION, Tech (JIDOC) :
| HAY, Greg (GREGH) 1
: MCDONALD, Shirley (CNWSAS1) :
: THOMPSON, Greg (DEMO3) 1
1 USER, Demo (110005) :
! 1
! 1
! 1
! 1
! 1
! 1
! 1
! 1
! 1
! 1
! 1
! 1
! 1
! 1
! 1
! 1
! 1
! 1
! |
! |
! |
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Remove a Case Team from a Case
1. Open the required case.
2. Select the Access tab.
3. Select the case team you want to remove in the Selected area > Select the Select icon.
4

Select Save > Select Yes to confirm you want to remove the case.

[ o e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e 1
: ﬁ Case File [URN: 2] Details  Contents  Entities Threads  Disclosure
Access
O Designations O Teams O Users @ Case Teams Q Selected
Armourer - Teams
+ & All users

- Individual Users
+ & BOBSON, Johnny John (110008)
# DOCUMENTATION, Tech (JIDOC)
+ 4 MASON, Robert (DEMO1) [Deactivated]
- (Case Teams

. *» Photographer

L e e e e e e -

Access to Source Entities

Some users and teams automatically have access to particular types of source entities.

Depending on your permission levels, you can give users and teams access to different types of source
entities.

For more information, see Maintaining Entity Types in the Admin Guide.

If you have permission to add security access in a case, you can set access to source entities in that case.

Managing Source Entities

The process of creating a source entity is similar for all source entities.
It's also possible to create a source entity from a Word document.

Before you create a source entity, run a search to make sure it doesn't already exist in your ICM
database. You'll also need to create an information report, incident report, or case file before you can
record information about an investigation.

Once you have created a source entity, you can edit, delete, or reinstate the entity.

You can also add tangible entities to the source entity.
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Create an Incident or Information Report from a Word or PDF
Document

This is quicker than creating these reports manually:

1. Select Incident Reports or Information Reports > Select Create from Word/PDF
documents.

2. Select the type of source entity you want to create from the Source entity type drop-down.

3. Select the Document direct checkbox if you just want to attach the document to the source
entity.

See Specifying Options for Source Entities Other than a Case in the Admin Guide.
4. If you did not select the Document direct checkbox:
o Inthe Document type drop-down, select the type of source document.

o Inthe Relationship drop-down, select the type of relationship you're creating between the
source entity and the document.

Use the Security access area to specify the users and teams who can access the document.

6. Select the Browse button beside the Directory field > Specify a location for the report > Select
OK.

7. To show any documents in the subdirectories of the selected directory, select the Include
subdirectories checkbox.

The Word (.doc) or PDF (.pdf) documents in the directory display in the table at the bottom of the
screen.

Documents that can be uploaded have black text. Directories have blue text. Documents that have
already been uploaded have red text.

8. To preview a document, select the listing > Select it in the Document field.
9. Select the checkboxes beside the documents you want to upload.

10. Select Create > Select Yes to confirm you do want to create the selected documents.

[} T ..
1 E Create incident reports from Word/PDF documents

Selection details

Source entity type [Palice Incident Report - Document direct []
Cocument Type [Document -
Relationship [Referenced By -
Security profile default security profile -

Security access

I
I
| I
1 I
1 I
1 I
1 I
1 I
1 I
1 I
1 I
1 I
1 I
1 I
1 I
: O Designations ~ ® Teams O users Q Selected :
1 All Users ; - Teams :
: Executive ." Surveillance Operatives 1
1 Investigation Team 1 - - Individual Users 1
: Users in Surveillance Operatives # DOCUMENTATION, Tech (JIDOC) :
1| BRIAN, Clark (DEMOZ) = :
: DOCUMENTATION. Tech (1T00CY - 1
1 I
. r I
: Directory C:\Users\cnwsh8\Documents\My Profiles\Incident Report |
: [ include sub-directories :
[l Unselect all = Document 3 :
I
1 Sel File Bytes Date modified Incident Report — Import :
I v R AP 3 \ iles\Inci
| v Ci\Usershcnwsha\Documents\My Profiles\Incident Report Who dunnit? 1
1 Incident Report.docx 11716 12/07/2017 15:43 :
:_ Mrs. Appleby in the living room with a rolling
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Edit a Source Entity
1. Open the source entity you want to edit.
2. Made the required changes.

3. Select Save.

T — 1
: ﬁl Information Report 8 Entities (1) Access Comments (0) Tasks (1) Threads (*) History ==
Details 4
Title ITheft of vehidle i s Diagram
. . Selected o=
Description Wehicle reg FRD342 White Toyota Camry stolen from 23 .
Kings Street, Woodend between the hours of 11 pm and 6:30 - IR Status (*)

am 22/2/2014. Owner Grian Smith reported theft by phone to ~ walidated
Rangiora Police. ;
- Walidating Officer (+)

ADMINISTRATOR, Default Agency (DEFLTADMIN)
- IR Source (*)
General Public
- Activity Type (*) (+)
Wehicle Theft
- Admiralty Rating (*)
- Source Reliability
C - Fairly Reliable
Draft O - Information Accuracy

. 2 - Probably True

Classification

When Actioned  |03/03/2014 it [19:26 e®

-

Disclosure

[ Excluded

[ signed off for disclosure

Bulk entities sign off in this source Bulk =sign off

Delete a Source Entity
1. Open the source entity you want to delete.
2. Select Delete > Select OK to confirm you want to delete the source entity.
3. Enter a reason for deleting the source entity in the popup window.

To see a deleted source entity, do an audit or reinstate the entity.

I o o e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e o o e e e e e o e o e e 1
: ﬂ Case File 16 Details Contents E a5 Access Threads Disclosure DHisser :
[} 1
: Details 1
1
! case officer DOCUMENTATION, Tech (JIDOC !
| mems BT i
: Title Murder in the Library :
I e r
| Uescripuon 20/07/2017 :
[} 2017 1
! o I
: Please enter reason for deleting Murder in the Library uspended (07/07/2017 135:45 - 07/07/20)
o 1
: Created in error |
. :
[} 1
[} 1
[} 1
[} 1
[} 1
[} 1
[} 1
[} 1
[} 1
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Reinstate a Deleted Source Entity
You might want to reinstate a source entity if you deleted it accidentally:
1. Open the source entity you want to reinstate.
It might be available in the Recent section of the Navigator.
2. Select Cancel to acknowledge and close the Reason Deleted window.
Select Undelete.

4. Select Yes to confirm you do want to reinstate the entity.

Title [Avocado Theft

Description .Investigation into supermarkets buying stolen avocados

e e et b e Cancel 0K
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Change an Entity's Classification

Your agency might have a data access restriction policy.

You might use security permissions in applications to prevent access to data. You might also label printed
documents like reports as confidential.

To support these requirements, ICM lets you classify entities. This happens automatically when you
create a new entity.

The new entity inherits the default classification for that type of entity.
To change an entity's classification:

1. Open the entity.

2. Make sure the Details tab is selected.

3. Select the required option from the Classification drop-down.

ﬁ: Information Report 8 Entities (1)
Details

Title "Theft of Vehicle

Description [Vehicle reg FRD342 White Toyota Camry stolen from 23

Kings Street, Woodend between the hours of 11 pm and
6:30 am 22/2/2014. Owner Grian Smith reported theft by
phone to Rangiora FPolice.

Crraft [l

Classification Restricted H
Top Secret .

When Actioned Secret 52 19:26 L L
Caonfidential

- Restricted

) Unclassified
Disclosure
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See Who Has Accessed and Updated a Source Entity

1. Open the required source entity.

2. Select the History tab:

3. Select the required subtab:
o Designation access to see which designations have had access to the case.
o Team access to see a record of access by teams.
o User access to see a record of access by users.

o Update history to see updates to the source entity by individual users.
™ —— T

1 é, Police Incident Repo rt 2009/ 11 Details Entities (0) Access  Comments (0) Tasks (0) Threads (0) History 1
I I
: History :
1 Designation access Team access  User access MULLEIEN TSGR 1
: Date Time User :
1 30/04/2014 13:58:10 DOCUMENTATION, Tech (JIDOC) 1
I |15/04/2014 15:11:18 DOCUMENTATION, Tech (JIDDC) 1
1 16/04/2014 15:09:45 DOCUMENTATION, Tech (JIDOC] 1
L d
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Access Threads for a Source Entity

Lots of information is collected during a case investigation.

The connections between pieces of information are called threads. Threads show the different lines of
enquiry taken during an investigation. They provide structure for recording information about an
investigation.

Thread entries are only available for case notes, incident reports, information reports, tasks, and task
results.

To see the threads for one of these types of source entities:
1. Open the source entity.
2. Select the Threads tab - You'll see a list of thread